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The 

 
Akers-Barnes Cockpit, Mark 1 

Revision 1.6d (metric and imperial) 

 

Thank you for your interest Flying Furniture’s Akers-Barnes Cockpit, Mark 1. 

The Akers-Barnes Cockpit, Mark 1 (ABC Mk1) is designed as a light weight, portable and easy to build cockpit for the 
computer flight simulation enthusiast.  The key element of the design is its simplicity of construction; requiring only 
some flat sheets of plywood and a saw, with no nails, screws, glue or dowels.  This simplicity also makes the cockpit 
highly portable – it can be put together and taken apart in a matter of minutes, and will easily fit in the boot (trunk) of 
even a small car.  The cockpit is also adaptable, and can be adjusted to suit people of different heights and builds. 

Legalese 

This design is Copyright © Peter Akers and Michael Barnes, 1999.  All rights reserved. 

Permission to utilise this design to construct a cockpit, or to adapt this design to another application, must be obtained 
in writing or e-mail from Peter Akers or Michael Barnes.  We apologise for this requirement, but we wish to retain the 
rights to this design should we ever intend to go into commercial production.  In order to retain those rights, we can 
only allow the design to be utilised under license. 

However, we are happy to grant license to members of the on-line flight simulation community who would like to use 
our design to construct a cockpit for their personal use, provided you contact us for permission.  We do not charge for 
use of the design, though donations are gratefully accepted.  If you obtained this document from a friend, and would 
like to use the design, please contact us at the e-mail addresses below. 

For permission to utilise the design for commercial production, please contact us for licensing arrangements. 

Contact Information 

Flying Furniture flyingfurniture@powerup.com.au 

Michael Barnes gengis@powerup.com.au 
  127 College Road, Karana Downs, 4306, Queensland, Australia. 

Peter Akers akersp@ozemail.com.au 

You can also find this information, and the latest version of this document, at the 62nd Fighting Falcons web site: 
http://www.62ndfightingfalcons.asn.au/ 

Disclaimer 
Peter Akers and Michael Barnes take no responsibility for injury to person or property that arises during the 
construction or use of the cockpit described here.  You must use your own judgement as to the quality of materials 
and workmanship required, and your own competence to undertake the construction. 



 

The Flying Furniture ABC Mk 1  Copyright © Peter Akers and Michael Barnes, 1999.  All Rights Reserved  Page 2 

Construction 
The process of constructing the ABC Mk1 is very simple: 

1. Mark out the pieces on a sheet or sheets of plywood, using the dimensioned plans below for sizes.  The actual 
layout of the pieces will depend on the size of the plywood sheets you use. 

2. Cut out the pieces 

That’s it – your cockpit is now ready to use!  It couldn’t get much simpler than that, could it? 

Of course, there is still finishing to do, should you want to: 

3. Fill any chips and nicks along the cut edges 

4. Sand all of the cut edges smooth 

5. Paint all of the pieces 

6. Cut out and cover a foam cushion for the seat. 

7. Add any clips, hooks or Velcro strips you require to attach your keyboard and joysticks. 

Materials 

The materials required are: 

Metric Version (See Figure 2a) Imperial Version (See Figure 2b) 

• 6 x 900x1200 sheets of 12mm thick 5 ply plywood (A-
B grade or higher quality) or, 
2 x 1200x2400 sheets of 12mm thick 5 ply plywood 
(A-B grade or higher quality)  
You can use different sized sheets, but you will need 
a minimum dimension of 1100mm for the largest 
pieces. 

• 550mm of 24mm diameter steel pipe, or equivalent 
diameter wooden rod. 

Foam rubber for the seat.  75mm thickness is 
recommended, the denser the better.  You will need 
450x550 for the seat, 450x815 for the back, plus an 
additional 240x210 if you want a double thickness on the 
headrest. 

• 6 x 3ft x 4ft sheets of 1/2 inch thick 5 ply plywood (A-
B grade or higher quality) or, 
2 x 4ft x 8ft sheets of 1/2 inch thick 5 ply plywood (A-
B grade or higher quality)  
You can use different sized sheets, but you will need 
a minimum dimension of 43 1/4 inches for the largest 
pieces. 

• 20 inch long, 1 inch diameter steel pipe, or equivalent 
diameter wooden rod. 

Foam rubber for the seat.  3 inch thickness is 
recommended, the denser the better.  You will need 
15 3/4 x 17 1/2 for the seat, 17 1/2 x 25 1/2 for the back, 
plus an additional 9 1/2 x 8 if you want a double thickness 
on the headrest. 

 

Equipment 

We have found the following equipment to be helpful when constructing a cockpit: 

• A pencil 

• A straightedge, 1m (3ft) long 

• A tape measure 

• A circular saw for the long cuts 

• A jigsaw for the notches and fiddly bits 

• A rasp, for adjusting the fit of the notches. 

• A pair of sawhorses or suitable workbench 
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Notes 

Notes for Metric Version only 

• The plans are designed for 12mm thick ply.  If you use a different thickness of plywood you will need to adjust the 
widths and positions of all the slots and the height of the tabs accordingly.  To assist with this, use the red lines in 
figure 3. 

• It is useful to have the slots on parts (A) and (D) (only) to be a few millimetres closer to the centre of the cockpit 
(horizontally as they appear in figure 3).  This is so that they fit tightly and lock into place.   
Note: The plans already have them shown as .25cm closer than might be expected.  You do NOT need to adjust 
these measurements to make the fit tight. 

Notes for Imperial Version only 

• VERY IMPORTANT! 
To date, no cockpit has been made using the imperial version of the plans in this document.  Please take great 
care to double check the measurements of the line out points (Figure 3).  Please contact us if you do use the 
imperial version, and tell us of any incorrect measurements, or if everything is correct. 

• The plans are designed for 1/2 inch thick ply.  If you use a different thickness of plywood you will need to adjust 
the widths and positions of all the slots and the height of the tabs accordingly.  To assist with this, use the red 
lines in figure 3. 

• Unlike the metric version, the all the slots and cut-outs are drawn at exactly the same as the thickness of the 
timber sheets (1/2 inch).  They really should be about 9/16 inch.  As a result, it is important that you cut the slots 
and cut-outs just slightly on the outside of the lines as you mark them on the wood.  If you don’t the pieces will all 
be a very tight fit. 

• It is useful to have the slots on parts (A) and (D) (only) to be a few millimetres closer to the centre of the cockpit 
(horizontally as they appear in figure 3).  This is so that they fit tightly and lock into place.   
Note: The plans already have them shown as 1/4 inch closer than might be expected.  You do NOT need to 
adjust these measurements to make the fit tight. 

Notes for Both Versions 

• The dimensions for the metric and imperial versions are not interchangeable.  Use only one version for all 
measurements. 

• We have found that use plywood produces the strongest and best results, but may people have successfully used 
Medium Density Fibreboard (MDF).   
NOTE: If you use MDF, care should be taken to avoid breathing in the dust while cutting.  

• Figure 3 is included to use as a reference when marking the wood before cutting.  Most of the measurements in 
the cockpit are fairly flexible. However, the red lines indicate those slots and tabs that must line up. 

• There are several possible positions for the seat included in the plan.  You can vary this further by changing the 
dimensions of the relevant pieces: 

1. The forward holes in parts (N) and (O), and the full size version of part (G) are used in conjunction with 
putting part H in the forward seat slot.  This gives a fairly upright seat position, closer to the monitor screen 
and front panel. 

2. The rearward alternate, holes in parts (N) and (O), and the cut down part (G) are used in conjunction with part 
I in the forward seat position.  This seat position is well suited for taller people or if you prefer a greater 
inclination of the seat back.  The inclination this gives is closer to that found in a real F-16’s cockpit. 

• You will probably want to trim the height of the front console to suit the size and position of your monitor.  This will 
vary depending on your hardware, and whether you have a desktop case under the monitor or a tower case 
beside the console.  We have also found that sloping the ‘shoulders’ of the front panel as indicated on the plans 
produces a more attractive result. 

• The two notches on each side of the foot well area of the part (A) design to accept parts (P) and (Q) (the steering 
wheel and keyboard trays) will probably be too tight and will need to be reshaped slightly with a file or rasp.  The 
top back, and bottom front of each notch (as seen from the front when the desk section is fully assembled) will to 
be shaved.  This will only be obvious when you put the tray parts into the notches and through to the cut-outs in 
part (B).   

• We have found that building a small ‘wedge’ out of the scrap timber, to tilt your joystick forward about 20 degrees, 
makes it more comfortable to use in a ‘sidestick’ position. 
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• Parts  (H), (I), (J) and (K) have alternate dimensions marked which allow for wider seat side shelves (strakes).  
These alternate dimensions should be used if you have a wide based joystick and/or throttle (wider than the 
earlier Thrustmaster FLCS+TQS combination). Technically, the standard dimensions are suitable for the 
Thrustmaster HOTAS Cougar, however they are a fairly tight fit and you may prefer the extra space of the wider 
version. 

• We have no specific recommendations for making the seat cushions.  Many different approaches have been used 
with varying success. 

The original cockpits used 7.5cm (3 inch) thick foam rubber with a variety of coverings, including home mage, 
professionally upholstered, and a lycra car seat cover.  

The foam proved suitable for the back but it was too soft for the seat so we added a 1.5cm high density foam 
rubber mat under the seat cushion. A suitable material would be the stuff they use for camping/hiking sleeping 
mats, which can be purchased very cheaply at camping/outdoor stores.  

We would recommend that you design the seat cushion with extra padding for your lower back.  

Headrests. Don't follow my wedge shaped design (which is seen in many of the photos). It doesn't support your 
neck well. Michael's design is quite good. It is two 10cm slabs put together with a 45degree slice taken out of the 
lower edge of the top slab.  

 

 

Figure 1: The assembled cockpit 
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Figure 2a: The pieces required and their dimensions 
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Figure 2b: The pieces required and their dimensions 
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Figure 3: The relationships between the key dimensions 
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Figure 4: One possible nesting for 2400 x 1200 mm Sheets (Metric Version) 
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Figure 5: One possible nesting for 1200 x 900 mm Sheets (Metric Version) 
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Assembly 
Assembling the ABC Mk 1 is rather like putting together a jigsaw puzzle. 

Start with the seat: 

1. Put the side piece (O) in position. 

2. Fit the cross pieces (H) and (I) into the slots on the base of (O), putting either (H) or (I) in the forward slot, 
depending on your preference of seat position. 

3. Put the other side piece (N) in place on the cross pieces. 

4. Slide the back support (G) into the upper slots of the side pieces (N) and (O). 

5. Slide the seat supporting rod into place through the appropriate holes in the side pieces.  Ensure that 5mm or so 
protrudes on each side. 

6. Place the seat base (M) on top of the front crosspiece and the seat supporting rod, so that the slots in the seat 
base are just in front of the rod. 

7. Slide the seat back (L) into the slots on the base, and snug it up against the supporting bar.  At the top tt should 
rest back against the back support (G). 

8. Add the side strakes (J) and (K).  The tapered ends go to the rear.  Tilt them slightly to slip the notches into the 
slots on the side pieces, and then lock them down onto the cross pieces.  The notches on the outer edges of the 
strakes should lock with the tabs on the side pieces. 

Add the cushions and your seat is completed! 

 

To assemble the console: 

9. Position the left side piece (F) 

10. Drop the two cross pieces (B) and (C) into the slots.  Piece (B) must go into the slot towards seat section (toward 
the sloping front of the side piece). 

11. Slide the right side piece (E) into the slots at the other end of the cross pieces. 

12. Slot the console top (D) onto the tabs on top of the side pieces.  Note that the top is not symmetrical – there is a 
‘front’ and a ‘back’.  The front will come slightly short of the front edge of the side pieces, to leave room for the 
front panel (A).  If necessary, flip the console top over. 

13. Slot the front panel (A) onto the tabs on the sloping front of the side pieces.  A tight fit is best here, to ensure that 
you do not accidentally knock the front panel off if you bump it.  If necessary, build up the tabs on the side pieces 
with some wood filler, or add locking clips to hold the front panel in place.  If you construct the front panel with the 
slots slightly misaligned, it will make a tight fit that will hold the panel stable. 

14. Slot in the required tray piece (P) or (Q) into the front panel through to the cross piece (B).  Use the upper or 
lower slots as required.  Use piece (P) for a keyboard or piece (Q) for a steering wheel. 

 

With the seat and console assembled, simply slide the seat into place in front of the console. 

If you are using the steering wheel tray, or do not wish to use the keyboard tray, you can hold your keyboard in place 
on the front panel by either: 

• Using self-adhesive Velcro strips under the keyboard and on the front panel,  

• or screw a rail or support across the bottom edge of the front panel,  

• or add pegs or hooks onto the front panel to hang the keyboard on. 

Your joysticks can be placed on the side strakes.  If you need to fasten them in place, use self-adhesive Velcro strips, 
or even Blu-Tack (which, if you don’t know it, is a reusable putty-like adhesive).  If you need to run cables between a 
joystick and throttle, pass them through the small cut-outs just behind the forward cross-piece. 

Adjust the position of the seat, console and your rudder pedals to suit your arm and leg length. 

 

 

Happy Flying! 
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APPENDIX 

Trick to print the plans larger, on a A4 (or US letter) printer 

Note: These instructions work for most version of Microsoft Word, though the some of the menu item names changed 
between versions. 

If you have difficulty reading the plans above, one trick that you can use to print them much larger is to: 

• Copy the graphic of the plan.  – Right mouse button click on the plan, then select “copy”. 

• Create a new blank document.  – Click on “File” menu and select “New”. 

• Change the margins to the smallest your printer will accept. – Click on “File” menu and select “Page Setup”. 
 – Set all four margins to 1cm (1/2 inch). 
 – Click “Ok” 

• Paste the plan into the new document. – Click on the “Edit” menu and select “Paste”. 

• Enlarge the plan. – Right mouse button click on the plan and select “Format Picture”.  
 – Click on the “Size” tab and type 160% (110% for the imperial plans) into the 
    Scale-Height field. 
 – Click “Ok” 

• Zoom out to see the whole page. – Click on the ‘View” menu and select “Zoom”.  
 – Click on the “Whole page” radio button. Click “Ok”. 

• Print this page. – Click on the “File” menu and select “Print”. 

• Float the plan. – Right mouse button click on the plan and select “Format Picture”.  
 – Click on the “Position” tab and tick the “Float over text” check box. 
 – Click “Ok” 

• Print this page. – Click on the “File” menu and select “Print”. 

• Now you can discard the document. 

You will now have a double sized print out of the plan that can be manually glued together. 

Credits 
Thank you to the following people for assistance with the creation of the plans: 

• Allen Pawley – for his revolutionary cockpit design, which inspired us to create the ABC Mark 1. 

• Peter Creed – for assistance with getting the dimensions correct for metric Revision 1.6 

• Frits van Voorst – for prompting the seat cushion discussion. 

• Ed Henderson – for the original imperial conversion. 

• Many others, for corrections and encouragement. 

Version History 

Word Doc Metric Imperial  

0.1 – 1.3 0.1 – 1.3 - Experimental Versions.  None were release to the public. 

1.4 1.4 - First Released Version 

1.4a – 1.4f 1.4a – 1.4f  Various corrections. 

- - 1.4d A separate imperial version created and released by Ed Henderson. 

1.5 – 1.57 1.5 – 1.57  Experimental Versions.  None were release to the public.   
First plans to include the Keyboard and Steering Wheel tray.  
Other minor corrections. 

1.6a –1.6b 1.6.0 1.6.0 Experimental Versions.  None were release to the public.  
New imperial version included. 
Change to the Version Numbering 
- a..z designation now indicates changes to this word document.   
– the plans will have 0..999 designations and may be different for the metric and imperial 
versions. eg. 1.6c of the Word Document contains the 1.60 metric and 1.60 imperial 
versions because the text changed but not the plans. 

1.6c   Version History Added.  Printing trick added. 

1.6d 1.6.1 1.6.0 Minor corrections. 900x1200 nesting added. 

 


